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Notes

Trademarks

Revisions

1st Edition: February 2026 (YMI)

This user’s manual contains useful information about the precautions, functions, and
specifications of the DL950/SL2000 File Utility Software.

To ensure correct use, please read this manual thoroughly before operation. Keep this
manual in a safe place for quick reference.

For information about the handling precautions, functions, and operating procedures of
the DL950/SL2000 series and the handling and operating procedures of Windows, see
the relevant manuals.

The contents of this manual are subject to change without prior notice as a result of
improvements to the product’s performance and functionality. Refer to our website to
view our latest manuals.

The figures given in this manual may differ from those that actually appear on your
screen.

Every effort has been made in the preparation of this manual to ensure the accuracy
of its contents. However, should you have any questions or find any errors, please
contact your nearest YOKOGAWA dealer.

Copying or reproducing all or any part of the contents of this manual without the
permission of YOKOGAWA is strictly prohibited.

Microsoft, Windows, Windows 10, and Windows 11 are registered trademarks or
trademarks of Microsoft Corporation in the United States and/or other countries.
Adobe and Acrobat are either registered trademarks or trademarks of Adobe Inc.

In this manual, the ® and TM symbols do not accompany their respective registered
trademark or trademark names.

Other company and product names are registered trademarks or trademarks of their
respective holders.

1st Edition: February 2026

All Rights Reserved. Copyright © 2026 Yokogawa Test & Measurement Corporation
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Notes on Usage

Handling Precautions

Disclaimers

This software is a DL950/SL2000 File Utility for the DL950/SL2000 series. It cannot be
used with other products.

By downloading and installing this software, the customer agrees to all of the following

disclaimers.

* Yokogawa bears no liability for any problems occurring as a result of downloading or
installing this software.

* Yokogawa bears no responsibility for any damage caused directly or indirectly as a
result of using this software.

+ This software is provided free of charge, however no unlimited warranty against
software defects exists, nor is any claim made that the product is free of all defects
whatsoever. Also, Yokogawa is not always able to repair defects (“bugs”) in, or
respond to questions or inquiries about this software.

* Yokogawa reserves all rights to this software, including but not limited to all property
rights, ownership rights, and intellectual property rights.
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Chapter 1 Software Overview

1.1 Software Overview

Overview
This software provides functionality to enable the opening of waveform data files that

could not be properly saved due to unexpected issues (such as a power outage) during
SSD recording with the DL950/SL2000.

In addition, it provides a function to merge waveform data files recorded on the DL950/
SL2000 in free-run mode into a single file and save it, as well as a function to add
supplemental data to speed up analysis.

Functions
This software provides the following functions.

+ File Merging: Merges consecutive free-run files into a single file.
» Finalization: Recovers incomplete waveform data files from SSD recording and
accelerates the handling of waveform data files recorded in free-run mode.

System requirements
The software requires a personal computer that satisfies the following system

requirements.
* Operating System:

Japanese or English version of Microsoft Windows 10 or Windows 11
* Memory: 8 GB or more
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Chapter 2  File Utility Features

2.1 File Utility Features

This software provides the following functions for waveform data files saved on the DL950/SL2000.

File merging
» Combines consecutive files saved in free-run recording into a single file
+ If the merged file exceeds 2 GB, lets you choose whether to save it as multiple files in 2 GB
increments or as a single file larger than 2 GB

Applicable files
Consecutive waveform data files saved to the instrument in free-run recording

File name
The file is saved either with an “m” inserted before the serial number (_000) of the first file to be
merged or with the file name you specify.

Finalization
» Arecovery function that allows waveform data files to be opened in viewer software such as
1IS8000 when file saving does not complete properly due to an abnormal event (such as a power
failure) during SSD recording
» Adds supplemental data to waveform data files saved in free-run recording so that they can be
opened quickly when analyzed in viewer software such as 1S8000

Applicable files
» Waveform data files from SSD recording that have not been closed
+ Waveform data files saved in free-run recording

The following files cannot be finalized:
» Waveform data files saved using dual capture
» Waveform data files saved using triggered measurement

File name
You can either overwrite the original file with the same file name or save it with the same name in
the Finalize folder created under the folder that contains the original file.
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2.2 Starting and Exiting the File Utility

Starting the File Utility

Use one of the following methods to start the software.
* On the Windows Start menu, click YOKOGAWA and then DL950 SL2000 FileUtility.
* Double-click the DL950 SL2000 FileUtility shortcut icon on the desktop.

DLg50 SL2000
FileUtility

Shortcut icon

Once started, the following screen appears.

- - - S—— Close button
Finalize tab

Input File Browse Update

File Name Wysmn) File Type | Sample Rate | Measuring Time | Measuring Start Time | Measuring End Time | Record Length | Final,
File Marge tab

W Sove vy 268
[ frowse | ||
[ =

Exiting the File Utility
To exit the file utility, click the Close button in the upper right of the file utility window. Alternatively, on
the File menu, click Exit
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2.3 File Merging

1. Start the file utility, and then click the File Merge tab.

_ _ ————

- Browse button

Fil

FieMerge | e

Bowe | | opaoe | Update button

FileName | Model Name (Version) | File Type | Sample Rate | Measuring Time | Measuring Start Time | Measuring End Time | Record Length | Final

. File Marge list

T — T~  Cancel button
—— N | Cancel All button
_oee |

2. Divided file saving
If the combined file size exceeds 2 GB and you wish to save it by dividing the file, select the Save
Every 2 GB check box.

3. Registering Files in the File List
Click Browse next to Input File to select the files that you want to use or drag the files directly to the
file utility window’s file list. The selected files appear in the file list.
To delete files from the file list, click the file that you want to delete (this selects the file), and then
click Cancel or press DELETE. To delete all files from the file list, click Cancel All.

4. Setting the Save Destination for the Merged File
Click Browse next to Merged file name to specify the name for the merged file.
If you do not specify a merged file name, the file is saved with an “m” inserted before the serial
number (_000) of the first file, in the same folder as that first file.

5. Selecting the Source Files
Files selected for File Merging are those that are highlighted in the file list.
Click the file that you want to use to select it. If you hold down SHIFT and click a file, you can select
multiple consecutive files. If you hold down CTRL and click files, you can select just the files that you
click.

6. Executing the File Merging
Click Execute to merge the files that are selected on the file list. If you have selected multiple files,
they are all merged collectively.
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2.4 Finalization

1. Start the file utility, and then click the Finalize tab.

N ‘ Browse button

Update button

e | Measuring Start Time | Measuring End Time | Record Length | Final,

| Finalize list

— | — Cancel button

Cancel All button
Overwrite checkbox

2. If you want to overwrite the original file with the finalized file, select the Overwrite check box.

3. Registering Files in the File List
Click Browse next to Input File to select the files that you want to use or drag the files directly to the
file utility window’s file list. The selected files appear in the file list.
To delete files from the file list, click the file that you want to delete (this selects the file), and then
click Cancel or press DELETE. To delete all files from the file list, click Cancel All.
You can change the order of the files in the list by dragging them to different positions.

4. Selecting the Source Files
Files selected for finalization are those that are highlighted in the file list.
Click the file that you want to use to select it. If you hold down SHIFT and click a file, you can select
multiple consecutive files. If you hold down CTRL and click files, you can select just the files that you
click. You can select up to 128 files.
For files that have not been finalized, the “Finalize” column displays “Undone.”

5. Executing the Finalization
Click Execute to finalize the files that are selected on the file list.
If you have selected multiple files, they are all finalized collectively. You can finalize up to 128 files at
once.

Files that were not properly saved—such as those affected by a power outage during data saving—
do not contain the supplementary information required for display in waveform viewer software such as
1S8000.

By performing finalization, the necessary information is added, allowing the files to be displayed in the
viewer software.
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2.5

Viewing the Manuals

With File Utility running, select Manual from the Help menu. The manual for this software will open.

Nofte

To view the PDF data, you need Adobe Acrobat Reader or a software application that can open PDF data.
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2.6 Viewing the Version

Start the file utility. On the Help menu, click ‘About DL950/SL2000 File Utility’ to view the version of
this software program.

About DL950/5L2000 File Utility

=123 DL950/SL200FieUtiity, Version 0.01
= (C) 2026 Yokogawa Test & Measurement Corporation.

Allrights reserved.
oK
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Appendix

Appendix 1 Error Messages

Messages may appear on the screen during operation. This section explains the causes.

Cause to appear

Message

When the files selected for merging have different
conditions, or when you select a trigger-mode file.

Files saved other than free run recording cannot be
merged. Please check the measurement conditions.

When you attempt to finalize a file that has already been
finalized

This file already finalized.

When you select a trigger-mode file during finalization

This file was measured using trigger mode and cannot
be finalized.

Please select a waveform data file recorded by SSD
recording.

When you have selected 1000 files or more when
merging files

The number of files to be merged exceeds 1000.
Limit the number of files to 1000 or less.

When you attempt to merge files whose measurement
times are not continuous.

The measurement times are not continuous.
Please select files with continuous measurement times.

When you attempt to merge files with different sample
rates

Different sample rate.Select files measured on the same
sample rate.

When you attempt to merge files measured with an
external clock and an internal clock

Files with external and internal clock sources are mixed.
Please select files with the same clock source.

When you select a file in dual capture mode

Cannot operate files measured in Dual Capture mode.

When you select a file from a different model

This file was measured by a device other than the DL950
or SL2000.

When the file you attempted to overwrite during
finalization was open in IS8000 or another application.

This file is read-only and cannot be modified.
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